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GNU GENERAL PUBLIC LICENSE

Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 
59 Temple Place - Suite 330, Boston, MA 02111-1307, USA 

Everyone is permitted to copy and distribute verbatim copies of this license document, but 
changing it is not allowed. 

Preamble

The licenses for most software are designed to take away your freedom to share and 
change it. By contrast, the GNU General Public License is intended to guarantee your 
freedom to share and change free software--to make sure the software is free for all its 
users. This General Public License applies to most of the Free Software Foundation's 
software and to any other program whose authors commit to using it. (Some other Free 
Software Foundation software is covered by the GNU Library General Public License 
instead.) You can apply it to your programs, too. 

When we speak of free software, we are referring to freedom, not price. Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free 
software (and charge for this service if you wish), that you receive source code or can get it 
if you want it, that you can change the software or use pieces of it in new free programs; and 
that you know you can do these things. 

To protect your rights, we need to make restrictions that forbid anyone to deny you these 
rights or to ask you to surrender the rights. These restrictions translate to certain 
responsibilities for you if you distribute copies of the software, or if you modify it. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must 
give the recipients all the rights that you have. You must make sure that they, too, receive or 
can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this 
license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone 
understands that there is no warranty for this free software. If the software is modified by 
someone else and passed on, we want its recipients to know that what they have is not the 
original, so that any problems introduced by others will not reflect on the original authors' 
reputations. 

Finally, any free program is threatened constantly by software patents. We wish to avoid the 
danger that redistributors of a free program will individually obtain patent licenses, in effect 
making the program proprietary. To prevent this, we have made it clear that any patent must 
be licensed for everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. 
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TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND 
MODIFICATION 

0. This License applies to any program or other work which contains a notice placed by the 
copyright holder saying it may be distributed under the terms of this General Public License. 
The "Program", below, refers to any such program or work, and a "work based on the 
Program" means either the Program or any derivative work under copyright law: that is to 
say, a work containing the Program or a portion of it, either verbatim or with modifications 
and/or translated into another language. (Hereinafter, translation is included without 
limitation in the term "modification".) Each licensee is addressed as "you". 

Activities other than copying, distribution and modification are not covered by this License; 
they are outside its scope. The act of running the Program is not restricted, and the output 
from the Program is covered only if its contents constitute a work based on the Program 
(independent of having been made by running the Program). Whether that is true depends 
on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you 
receive it, in any medium, provided that you conspicuously and appropriately publish on 
each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the 
notices that refer to this License and to the absence of any warranty; and give any other 
recipients of the Program a copy of this License along with the Program. 

You may charge a fee for the physical act of transferring a copy, and you may at your option 
offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a 
work based on the Program, and copy and distribute such modifications or work under the 
terms of Section 1 above, provided that you also meet all of these conditions: 

a. You must cause the modified files to carry prominent notices stating that you 
changed the files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part 
contains or is derived from the Program or any part thereof, to be licensed as a 
whole at no charge to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you 
must cause it, when started running for such interactive use in the most ordinary 
way, to print or display an announcement including an appropriate copyright 
notice and a notice that there is no warranty (or else, saying that you provide a 
warranty) and that users may redistribute the program under these conditions, 
and telling the user how to view a copy of this License. (Exception: if the Program 
itself is interactive but does not normally print such an announcement, your work 
based on the Program is not required to print an announcement.) 

These requirements apply to the modified work as a whole. If identifiable sections of that 
work are not derived from the Program, and can be reasonably considered independent and 
separate works in themselves, then this License, and its terms, do not apply to those 
sections when you distribute them as separate works. But when you distribute the same 
sections as part of a whole which is a work based on the Program, the distribution of the 
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whole must be on the terms of this License, whose permissions for other licensees extend to 
the entire whole, and thus to each and every part regardless of who wrote it. 

Thus, it is not the intent of this section to claim rights or contest your rights to work written 
entirely by you; rather, the intent is to exercise the right to control the distribution of 
derivative or collective works based on the Program. 

In addition, mere aggregation of another work not based on the Program with the Program 
(or with a work based on the Program) on a volume of a storage or distribution medium does 
not bring the other work under the scope of this License. 

3. You may copy and distribute the Program (or a work based on it, under Section 2) in 
object code or executable form under the terms of Sections 1 and 2 above provided that you 
also do one of the following:

a. Accompany it with the complete corresponding machine-readable source code, 
which must be distributed under the terms of Sections 1 and 2 above on a 
medium customarily used for software interchange; or, 

b. Accompany it with a written offer, valid for at least three years, to give any third 
party, for a charge no more than your cost of physically performing source 
distribution, a complete machine-readable copy of the corresponding source 
code, to be distributed under the terms of Sections 1 and 2 above on a medium 
customarily used for software interchange; or, 

c. Accompany it with the information you received as to the offer to distribute 
corresponding source code. (This alternative is allowed only for noncommercial 
distributionand only if you received the program in object code or executable form 
with such an offer, in accord with Subsection b above.) 

The source code for a work means the preferred form of the work for making modifications 
to it. For an executable work, complete source code means all the source code for all 
modules it contains, plus any associated interface definition files, plus the scripts used to 
control compilation and installation of the executable. However, as a special exception, the 
source code distributed need not include anything that is normally distributed (in either 
source or binary form) with the major components (compiler, kernel, and so on) of the 
operating system on which the executable runs, unless that component itself accompanies 
the executable.

If distribution of executable or object code is made by offering access to copy from a 
designated place, then offering equivalent access to copy the source code from the same 
place counts as distribution of the source code, even though third parties are not compelled 
to copy the source along with the object code. 

4. You may not copy, modify, sublicense, or distribute the Program except as expressly 
provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute 
the Program is void, and will automatically terminate your rights under this License. 
However, parties who have received copies, or rights, from you under this License will not 
have their licenses terminated so long as such parties remain in full compliance. 

5. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Program or its derivative 
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works. These actions are prohibited by law if you do not accept this License. Therefore, by 
modifying or distributing the Program (or any work based on the Program), you indicate your 
acceptance of this License to do so, and all its terms and conditions for copying, distributing 
or modifying the Program or works based on it. 

6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the 
Program subject to these terms and conditions. You may not impose any further restrictions 
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing 
compliance by third parties to this License. 

7. If, as a consequence of a court judgment or allegation of patent infringement or for any 
other reason (not limited to patent issues), conditions are imposed on you (whether by court 
order, agreement or otherwise) that contradict the conditions of this License, they do not 
excuse you from the conditions of this License. If you cannot distribute so as to satisfy 
simultaneously your obligations under this License and any other pertinent obligations, then 
as a consequence you may not distribute the Program at all. For example, if a patent license 
would not permit royalty-free redistribution of the Program by all those who receive copies 
directly or indirectly through you, then the only way you could satisfy both it and this License 
would be to refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply and the section as a whole is 
intended to apply in other circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property 
right claims or to contest validity of any such claims; this section has the sole purpose of 
protecting the integrity of the free software distribution system, which is implemented by 
public license practices. Many people have made generous contributions to the wide range 
of software distributed through that system in reliance on consistent application of that 
system; it is up to the author/donor to decide if he or she is willing to distribute software 
through any other system and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of 
the rest of this License. 

8. If the distribution and/or use of the Program is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the Program 
under this License may add an explicit geographical distribution limitation excluding those 
countries, so that distribution is permitted only in or among countries not thus excluded. In 
such case, this License incorporates the limitation as if written in the body of this License. 

9. The Free Software Foundation may publish revised and/or new versions of the General 
Public License from time to time. Such new versions will be similar in spirit to the present 
version, but may differ in detail to address new problems or concerns. 

Each version is given a distinguishing version number. If the Program specifies a version 
number of this License which applies to it and "any later version", you have the option of 
following the terms and conditions either of that version or of any later version published by 
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the Free Software Foundation. If the Program does not specify a version number of this 
License, you may choose any version ever published by the Free Software Foundation. 

10. If you wish to incorporate parts of the Program into other free programs whose 
distribution conditions are different, write to the author to ask for permission. For software 
which is copyrighted by the Free Software Foundation, write to the Free Software 
Foundation; we sometimes make exceptions for this. Our decision will be guided by the two 
goals of preserving the free status of all derivatives of our free software and of promoting the 
sharing and reuse of software generally. 

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE 
LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS 
AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY 
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 
DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. 

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE 
TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE 
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING 
RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR 
A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN 
IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. 

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs 

If you develop a new program, and you want it to be of the greatest possible use to the 
public, the best way to achieve this is to make it free software which everyone can 
redistribute and change under these terms. 

To do so, attach the following notices to the program. It is safest to attach them to the start of 
each source file to most effectively convey the exclusion of warranty; and each file should 
have at least the "copyright" line and a pointer to where the full notice is found; and one line 
to give the program's name and an idea of what it does. 

Copyright (C) yyyy name of author 
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This program is free software; you can redistribute it and/or modify it under the terms of the 
GNU General Public License as published by the Free Software Foundation; either version 
2 of the License, or (at your option) any later version. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR 
A PARTICULAR PURPOSE. See the GNU General Public License for more details. 

You should have received a copy of the GNU General Public License along with this 
program; if not, write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, 
Boston, MA 02111-1307, USA. 

Also add information on how to contact you by electronic and paper mail. 

If the program is interactive, make it output a short notice like this when it starts in an 
interactive mode: 

Gnomovision version 69, Copyright (C) year name of author 

Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'. This is 
free software, and you are welcome to redistribute it under certain conditions; type `show c' 
for details. 

The hypothetical commands `show w' and `show c' should show the appropriate parts of the 
General Public License. Of course, the commands you use may be called something other 
than `show w' and `show c'; they could even be mouse-clicks or menu items--whatever suits 
your program. 

You should also get your employer (if you work as a programmer) or your school, if any, to 
sign a "copyright disclaimer" for the program, if necessary. Here is a sample; alter the 
names:

Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision' (which 
makes passes at compilers) written by James Hacker.

signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice 

This General Public License does not permit incorporating your program into proprietary 
programs. If your program is a subroutine library, you may consider it more useful to permit 
linking proprietary applications with the library. If this is what you want to do, use the GNU 
Library General Public License instead of this License.

MAD 

This product contains module MAD, which is distributed in accordance with the terms of the 
GNU General Public License version 2, provided below.  

This product is licensed as described in “GNU GENERAL PUBLIC LICENSE” above.
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IP Softphone 2050 overview

The IP Softphone 2050 is a business telephone application that you can 
use to make and take calls over your computer. Using a headset or 
handset connected to your PC, you control calls with the click of the 
mouse pointer, from your PC keyboard, or from the USB Audio Adapter.

Designed to work with IP-based phone systems, the IP Softphone 2050 
provides Voice over IP (VoIP) services using a telephony server and your 
Local Area Network (LAN) or Wide Area Network (WAN). 

The server that supports your IP Softphone 2050 determines the features 
you can access, such as Call Conference, Call Transfer, and 
Call Forward.

Features

The IP Softphone 2050 supports the following features:

• Twelve user-defined feature keys: six Programmable Line 
(DN)/Feature Keys (self-labeled) and six lines/features accessed by 
pressing the shift key

• Four soft keys that provide access to a maximum of 10 features

• Four-line display

• Directory capabilities stored locally on your PC or linked to external 
directories, such as Lightweight Directory Access Protocol (LDAP), 
Microsoft Outlook, and Windows Address Book (WAB) contact 
management software

• Communication Server 1000 (CS 1000) Directory features (Personal 
Directory, Redial List, Callers List, and Password Administration) 
stored on the application server for systems running CS 1000 
Release 4.0 or later software

• One-click direct dialing from various windows and applications

• Five specialized fixed keys:

— Directory

— Inbox (Message)
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— Shift (Outbox)

— Services

— Expand

• Dedicated call processing keys: 

— Hold

— Goodbye

— Answer

— Volume

— Mute

— Navigation

— Message Waiting

• User-selected ringer that lets the PC speakers or the headset ring for 
incoming calls

• Choice of the following interfaces:

— 1100 series theme 

— Compact black and silver themes

— Accessibility Interface for the visually impaired

• Programmable hot keys that allow single key access to user-
definable features

• Two input modes: Numeric and Alphabetic

• Supported languages include: Arabic, Chinese (Traditional and 
Simplified), Czech, Danish, Dutch, English, Finnish, French, German, 
Greek, Hebrew, Hungarian, Italian, Korean, Japanese, Latvian, 
Norwegian, Polish, Portuguese, Russian, Spanish, Swedish and 
Turkish.

• Support for BlueTooth and standard USB headsets

• Expansion Module (EM)

• Drag and Drop dialing

• Macro functions available for programming long dialing patterns

• A check box for setting hook switch status
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• Always-on-top option that keeps the Call Control window on top of all 
other open applications

Components

The IP Softphone 2050 supports six main components: 

• “Call Control window” on page 17

• “Local Directory window” on page 17

• “Settings window” on page 17

• “System tray icon and menu” on page 18

• “Expansion Module” on page 18

• “i2050.exe application” on page 18

Call Control window
The IP Softphone 2050 Call Control window displays the line keys, 
feature buttons, and call display. Use this window to make and manage 
your telephone calls. You also use this window to access both your Local 
Directory and CS 1000 Directory features (Personal Directory, Redial List, 
Callers List, Application Server Administration, and Password 
Administration). 

For more information about the Call Control window, consult the IP 
Softphone 2050 User Guide (NN43119-101)

Local Directory window
Use the Local Directory window to create, manage, and use a telephone 
directory stored on your local computer and to access external 
directories, such as LDAP, Outlook, and WAB.

For more information about the Local Directory window, consult the IP 
Softphone 2050 User Guide (NN43119-101)

Settings window
Use the Settings window—a series of dialog boxes—to set up the various 
IP Softphone 2050 features.
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For more information about the Settings window, consult the IP Softphone 
2050 User Guide (NN43119-101).

System tray icon and menu
You can right-click the IP Softphone 2050 system tray icon—located at 
the right side of the Windows taskbar at the bottom of your screen—to 
make and manage calls.

Expansion Module
Use the Expansion Module (EM) to display the status of pre-programmed 
lines for other IP Phones on the network.

For more information about the Expansion Module, consult the IP 
Softphone 2050 User Guide (NN43119-101).

i2050.exe application
The i2050.exe application lets the IP Softphone 2050 communicate with 
the server. It launches when you start the IP Softphone 2050 but remains 
hidden in the background. To verify that the i2050.exe is running, open 
the Windows Task Manager. To view the i2050.exe process, select 
Processes. The process appears as long as the IP Softphone 2050 icon 
appears in the system tray. 
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IP Softphone 2050 
Call Control window

The IP Softphone 2050 Call Control window supports the 1100 theme—
designed to look and feel like the desktop IP Phone 1100 series—as well 
as an additional two compact themes, available in black and silver. The 
IP Softphone 2050 also supports an Accessibility Interface for visually 
impaired users.

To open the IP Softphone 2050 Call Control window:

1. From your desktop PC, select Start. 

2. Select Programs.

3. Select Nortel > IP Softphone 2050 > IP Softphone 2050.

Accessibility Interface

To open the IP Softphone 2050 Accessibility Interface from the Call 
Control window:

1. From your desktop PC, select Start > Programs > Nortel > 
IP Softphone 2050 > IP Softphone 2050.

The Call Control window opens.  

2. Click the Menu button.

3.  Select File > Settings > Theme.

4. Select Accessibility Interface.

Note: If the IP Softphone 2050 is running, you must exit and restart 
for the change to the Accessibility Interface to take effect.
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Call Control window

The Call Control window (see Figure 1 below and Figure 2 on page 21) 
includes the standard features that let you make and manage telephone 
calls.

For information on the elements of the Call Control window, see Table 1 
on page 22.

Figure 1: Call Control Window—1100 series theme
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Figure 2: Call Control Window—Compact Theme (silver)

Accessibility Interface

The Accessibility Interface works with JAWS® for Windows from 
Freedom Scientific—screen reading software that lets visually impaired 
users access the full range of IP Softphone 2050 features. The 
Accessibility Interface has been tested on JAWS® Version 5.0. The 
screen is divided into four groups of controls: Display, Line and Feature, 
Date and Time, and Indicators.   

Menu Command options in the Accessibility Interface match those in the 
standard Call Control window.

High Contrast Mode is a Microsoft Windows feature that increases 
legibility for visibly impaired users by increasing screen contrast. Activate 
this feature by navigating to Start > Control Panel > Accessbility 
Options > Display and selecting the High Contrast checkbox.

For more information about the Accessibility Interface, consult the IP 
Softphone 2050 User Guide (NN43119-101).
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Call Control window elements and functions

Table 1 describes the elements and functions of the Call Control window.

Table 1: IP Softphone 2050 components and functions 
(Part 1 of 4)

Element Function

Primary display To provide call information (such as Caller ID) 
and instructions for using certain soft key 
features. 

When idling, the telephone displays only the date 
and time.

Soft keys To access server-definable features, such as 
Transfer (for connecting calls to other people), 
Conference (for group calls), and so on. 

To select a feature, click one of the four available 
soft-labelled soft keys, and then follow the 
instructions on the display.

Available soft key features vary, depending on:

• Your current task: the features available at 
any time depend on your current call activity.

• Server support: IP Softphone 2050 
functionality depends on communication 
server configuration.

Note: To view additional features, click the 
More soft key.

Call/Answer To make or answer a call.

Copy To copy a network service, feature, or folder.

Quit To quit a network service or feature.
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Navigation arrows

To scroll through menus and lists in the display 
area.

Use the Send/Enter key at the center of the
navigation cluster to confirm menu selection
(1100 series theme only).

Volume

decrease

increase

To increase or decrease the volume.

Headset To answer and make calls using the headset.

Handsfree To answer and make calls using the handsfree
speaker.

Mute Mute key functionality is enabled or disabled by 
your system administrator. Contact your system 
administrator to determine if your Mute key is 
enabled.

If Mute key is enabled, click the Mute key to 
mute the headset and listen to the receiving party 
without transmitting. Click the Mute key again to 
return to two-way conversation.

Note: If  Mute key is not enabled, clicking the 
Mute key places the call on hold. Click the 
Mute key again to restore the active call or 
click the line key to restore the active call. 
You cannot retrieve this call from hold by 
clicking the Hold key.

The handset display indicates the Mute status 
(Mute On or Mute Off).

Table 1: IP Softphone 2050 components and functions 
(Part 2 of 4)

Element Function
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Hold To place an active call on hold. 

The feature key label for the line on hold displays 
a flashing icon to indicate that the call is on hold. 

Return to the call by clicking the Line button of 
the call on hold.

Release To terminate an active call.

Line keys To access one of six programmable Line keys. 
These keys can represent line appearances, 
DNs, or features. 

The communication server provides the labels 
that appear on these keys.

Dialpad To dial a telephone number. Use your mouse 
pointer to click the numbers you want to enter.

Directory To access CS 1000 Directory features. 

Depending on how the system administrator sets 
up this service, use this button to access  
Personal Directory or other server-based 
directory services. 

You can use CS 1000 Directory features to place 
a call. The call is placed on your prime line, 
unless you select a different line.

Services To access a list of network services.

Expand To access Graphical External Application Server
(GXAS) applications.

Table 1: IP Softphone 2050 components and functions 
(Part 3 of 4)

Element Function
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Hot keys

You can assign keyboard hot keys to access the full range of Call Control 
window functions and menu options.

Adding a hot key
To add a new hot key:

1. Click the Menu button.

2. Select File > Settings > Hot Keys.

3. Choose the feature group that you want to access: Buttons, Menu, 
or Select Fields (Accessibility Interface only).

4. From the Items list, select the feature to which you want to assign a 
hot key.

5. Under Press a new shortcut key, enter the key combination—“Alt + 
Ctrl + V”, for example—that you want as your hot key.

6. Click Assign. 

Note: If the key combination is already taken, the previously assigned 
feature appears in the Shortcut currently used by text box.

Note: To activate an item using the Select Fields feature group, click 
Enter.

Msg/Inbox

To access voice mail applications.

Note: You may also hear an audio Message 
Waiting Indicator (stutter or beeping dial 
tone) when you  obtain dial tone.

Shift/Outbox To access voice mail applications and toggle 
between feature key displays.

Table 1: IP Softphone 2050 components and functions 
(Part 4 of 4)

Element Function
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To assign a hot key, you can enter any keyboard key combination except 
for the following:

• A to Z

• Shift-A to Shift-Z

• Alt-A to Alt-Z

• 0 to 9

• Alt+0 to Alt+9

• Asterisk (*)

• Number sign (#)

• Up, down, left, and right arrow keys 

• Shift+Up, Shift+Down

• PageUp, PageDn

• Alt+F1 to Alt+F12

• F1, Shift+F1,Ctrl+F1, Ctrl+Alt+F1, Ctrl+Alt+Shift+F1

• Space bar

Removing a hot key
To remove a hot key:

1. Click the Menu button. 

2. Select File > Settings > Hot Keys.

3. Choose the feature group that you want to access: Buttons, Menu, 
or Fields (Accessibility Interface only).

4. From the Items list, select the feature from which you want to remove 
a hot key.

5. Click Remove. 
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System tray icon and menu

Use the IP Softphone 2050 system tray icon menu to manage phone calls 
and messages without opening the Call Control window. 

To access the menu, right-click the IP Softphone 2050 icon found in the 
Windows taskbar system tray. From the menu, you can make, answer, 
and manage your calls, as well as access macros and features.
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IP Softphone 2050 Directories

The IP Softphone 2050 uses two directories for maintaining and 
accessing contacts: the Local Directory, stored on your local hard drive, 
and the CS 1000 Directory, stored on your server.

• “Local Directory” on page 28

• “CS 1000 Directory” on page 30

Local Directory

Use the IP Softphone 2050 Local Directory to store and manage multiple 
phone directories on your computer. You can use the Shortcut Bar to 
organize your contacts into groups.

You can use the Local Directory to:

• Link to external directories such as Outlook, Act, and LDAP, and 
Windows Address Book (WAB).

• Dial from external directories.

• Save contacts locally to your computer.

• Filter long directories so they are easier to use.

Note: Do not confuse the IP Softphone 2050 Local Directory with the 
Network Directory (accessible by clicking  Directory on the 
toolbar).

The Shortcut Bar on the left side of the window lists all groups of shortcut 
links, including: 

• Local Directory—main directory contacts

• Quick Dials—a built in group for selecting shortcuts to contacts
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Opening a Local Directory from the Call Control 
window
To open a Local Directory:

1. On the Call Control window, click the Menu button.

2. Select View > Local Directory.

3. Select one of the following:

— On the Shortcut Bar, select Directories > Local Directory.

— On the menu, select Directory > View > Local Directory.

Note: To open a previously accessed Local Directory, click the Menu 
button and select File > Recent Directories, then select the Local 
Directory you want to open.

Directory entry management
The Directory Interface features management functions for entries 
located on a toolbar above the display screen.

Click New Contact to create new contact 
entries.

Click Properties to make information 
changes for contact entries such as e-mail, 
address, and company information.

Click Delete to enable the removal of a 
contact entry.

Click Find Contact to enable automatic 
search and find of a contact entry.

Click Filter to enable sorting of information 
for a contact entry.
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For  more information about managing contacts, refer to the IP Softphone 
2050 User Guide (NN43119-101).

CS 1000 Directory 

The CS 1000 Directory maintains contact information and server-
supported features in a remote, central database called the Application 
Server. Accessible from the IP Softphone 2050 Call Control window, the 
CS 1000 Directory supports the following features: 

• Personal Directory

• Redial List

• Callers List

To open CS 1000 Directory features:

1. On the Call Control window, click  Directory.

2. Scroll through the following list and click to select:

— Personal Directory

— Callers List 

— Redial List 

— Password Administration 

Note: The Personal Directory, Redial List, and Callers List features 
have a one-minute time-out control period. If the application rests idle 
for one minute during any of the operations, the list closes and your 
IP Softphone 2050 returns to the idle state.

For further information about CS 1000 Directory features (Personal 
Directory, Redial List, Callers List, Password Administration), consult the 
IP Softphone 2050 User Guide (NN43119-101). 

Click Dial to dial the default telephone 
number. Or click the arrow beside the button, 
and then click the desired number from the 
drop-down list.
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For further information about the Nortel IP Softphone 2050, consult 
IP Phones Fundamentals (NN43001-368).
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Agent and Supervisor features

This section describes login features common to the Call Center Agent 
and Supervisor. 

The IP Softphone 2050 supports six line (DN) and feature keys, 
accessible from the Call Control window. 

Figure 3: Line and feature keys

Use these keys to access and manage Call Center Agent and Supervisor 
features.

Depending on your system configuration, choose from the following 
methods of logging in and out: 

• “Logging in without Agent ID” on page 33 

• “Logging in with Agent ID” on page 33

• “Logging in using Agent ID and Multiple Queue Assignments” on 
page 34 

• “Logging out an agent” on page 37

WARNING
Once logged on, you will be placed into the queue for 
incoming calls. If you are unavailable or away from your 
phone, activate Make Set Busy or Not Ready to prevent 
callers from being directed to your phone.
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Logging in without Agent ID 

For basic ACD
If your ACD configuration does not rely on Agent ID, which is often the 
case if you do not share your phone with another person, use the 
following procedure to log in to an Automatic Call Distribution (ACD) 
queue.

Logging in with Agent ID 

For Basic ACD or Contact Center Manager
If your ACD configuration uses Agent ID, which is often the case when 
you share your phone with another person, use the following procedure to 
log in to an Automatic Call Distribution (ACD) queue. If an Agent ID is 
assigned to you, the display screen prompts you to enter a four-digit 
code.

Note: The following procedure applies if you are working in a Basic 
ACD environment or a Nortel Contact Center Manager environment. 
For more information about Nortel Contact Center Manager, visit 
www.nortel.com.

To login as an agent:

1. Click InCalls (Figure 3 on page 32).

2. If Enter Agent ID appears on the screen, use the keypad in the Call 
Control window to enter your Agent ID.

3. Click the pound key (#). 

The phone goes into a NotReady state.

4. Click InCalls to join the ACD queue, or click NotReady (Figure 3 on 
page 32).
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Logging in using Agent ID and Multiple 
Queue Assignments

If your configuration uses  Multiple Queue Assignment (MQA, use the 
following procedure. MQA login involves entering a four-digit Agent ID 
and up to five ACD Directory Numbers (DN), with the option of adding a 
Supervisor ID and up to five Priority values.

You can login using either of the following methods:

• Agent ID and MQA Login Option

• Default Login

Using MQA login options
To enter ACD queues, use an Agent ID login with one of the following four 
MQA login options: 

• No Supervisor ID, No Priority

• Supervisor ID, No Priority

• No Supervisor ID, with Priority

• Supervisor ID, with Priority

Note: If a supervisor logs in to accept ACD calls, then the system 
prevents the supervisor from entering a Supervisor ID. This includes 
logins in which agents are required to enter a Supervisor ID. 

Login Option entries
The login options require the following entries:

• A four-digit Agent ID

• A Supervisor ID (if your queue requires one)

• Up to five ACD DNs and priority values (if priority values are being 
used), terminated by ##.
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Logging in: No Supervisor ID, No Priority
To login using the No Supervisor ID, No Priority option:

1. Click InCalls.

2. Dial Agent ID #.

3. Dial ACD DN 1 #.

4. Dial ACD DN 2 #.

5. Dial ACD DN 3 #.

6. Dial ACD DN 4 #.

7. Dial ACD DN 5 ##.

Logging in: Supervisor ID, No Priority
To login using the Supervisor ID, No Priority option:

1. Click InCalls.

2. Dial Agent ID #.

3. Dial Supervisor ID #.

4. Dial ACD DN 1 #.

5. Dial ACD DN 2 #.

6. Dial ACD DN 3 #.

7. Dial ACD DN 4 #.

8. Dial ACD DN 5 ##.

Logging in: No Supervisor ID, With Priority
To log in using the No Supervisor ID, With Priority option:

1. Click InCalls.

2. Dial Agent ID #.

3. Dial ACD DN 1 #.

4. Dial Priority 1 #.

5. Dial ACD DN 2 #.

6. Dial Priority 2 #.
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7. Dial ACD DN 3 #.

8. Dial Priority 3 #.

9. Dial ACD DN 4 #.

10. Dial Priority 4 #.

11. Dial ACD DN 5 #.

12. Dial Priority 5 ##.

Logging in: Supervisor ID, With Priority:

To log in using the Supervisor ID, With Priority option:

1. Click InCalls.

2. Dial Agent ID #.

3. Dial Supervisor ID #.

4. Dial ACD DN 1 #.

5. Dial Priority 1 #.

6. Dial ACD DN 2 #.

7. Dial Priority 2 #.

8. Dial ACD DN 3 #.

9. Dial Priority 3 #.

10. Dial ACD DN 4 #.

11. Dial Priority 4 #.

12. Dial ACD DN 5 #.

13. Dial Priority 5 ##.

Click InCalls or NotReady to enter the ACD queue.

Note: To choose the default Priority or Supervisor ID, enter # 
instead of a Priority entry or a Supervisor ID entry (the Priority or 
Supervisor ID for your set is used).
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Using Default Login
If you normally use the same telephone for each shift, use the Default 
Login once at the beginning of a shift. The Default Login uses your 
previous shift’s login to place you in the same ACD queues and with the 
same Supervisor.

To use the Default Login (with MQA enabled):

1. Click InCalls. 

The Enter Agent ID message appears. 

2. Use the keypad to enter your Agent ID.

3. For Supervisor ID Required, click the pound (#) key three times.

4. To join the ACD queue, click InCalls or NotReady.

Logging out an agent

You can log out of the system either completely or temporarily (Not Ready 
state).

Logging out temporarily
Click NotReady. This removes you from the queue but keeps you logged 
in as an agent position.

Logging out
To log out completely, click MakeSetBusy.

Note: If you click MakeSetBusy while on an ACD call, you are 
logged out automatically when the call is finished.
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Agent features

The following sections describe features that are available to agents:

• “Incoming Call Notification” on page 38

• “Incoming Call Notification” on page 38 

• “Using Force Call” on page 39

• “Using Activity Code” on page 40

• “Using Emergency” on page 41 

• “Using NotReady” on page 43

• “Answering or making non-ACD calls” on page 43 

• “Contacting your supervisor” on page 43

Incoming Call Notification

A notification window appears above the system tray when incoming calls 
are received. This window displays the ringing line (DN) and the incoming 
caller’s name and number.

When this notification appears you can do one of the following:

— Click Answer to answer the call.

— Click Open to activate the IP Softphone 2050 Call Control 
window and select a call handling feature, such as forwarding the 
incoming call to another line or to voicemail.

— Click Close to close the notification window. This does not 
disconnect the incoming call, it only removes the message from 
your screen. You can also close the notification box by clicking 
the close button in the top right corner.

When the call is disconnected, a “call disconnected” notification appears. 
The incoming call notification window closes automatically when the call 
is disconnected.
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Answering ACD calls

Click InCalls to answer the next queued ACD call on the primary DN. You 
can find the InCalls key in the lower right-hand corner of the 
programmable line/feature keys (see Figure 3 on page 32). 

Answering a call
The indicator next to the InCalls key flashes on incoming calls.

To answer a call: 

• Click InCalls.

• On your PC keyboard, press Enter.

Note: The indicator remains lit while the call is active.

Terminating a call
To end a call, choose one of the following:

• Click  (Goodbye/Release).

• Click InCalls.
• Click the individual DN line key. (This removes you from the queue.)

• Click NotReady. (This removes you from the queue but keeps you 
logged in as an agent position.) 

• Wait for the caller to terminate the call.
• On your PC keyboard, press F12.

Using Force Call

Use the Force Call feature to automatically connect an incoming 
ACD call. Your system administrator sets the time interval for the period 
between incoming calls.

Note: You cannot use both Force Call and Return To Queue on No 
Answer at the same time. 
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When calls come in, a short tone indicates the new call. The InCalls 
indicator lights continuously and the ACD call automatically goes to your 
agent position.

To disconnect an active ACD call while Force Call (Auto Answer) is 
active, click InCalls.

Using Activity Code

Use the Activity Code feature to record the type of activity you are 
performing. If configured, you can enter Activity Codes while in the Not 
Ready state and run Not Ready Reason Codes by Agent report in 
Contact Center Manaer Administration to track Not Ready time..

To record an activity, do the following:

1. When the Activity indicator flashes, click Activity.

2. Use the keypad to enter the activity code.

3. Click Activity again.

If performing multiple tasks, repeat steps 1 through 3.

WARNING
If you are away from your phone and Call Forcing is  
enabled, remember to log out or activate Not Ready. 
Otherwise, the system connects call after call to your 
phone.  Each connected caller hears background noise, 
and eventually hangs up.
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Using Emergency

Use the Emergency feature to contact your supervisor immediately in an 
emergency situation. The Emergency indicator remains lit as long as the 
feature is active.

To use the Emergency feature, do the following:

1. During an active call, click Emergency.

When the supervisor picks up, a three-way call commences with you, 
the supervisor, and the caller.

2. Click Emergency again to transfer the caller to the supervisor and 
terminate your access to the call.

Using Record On Demand key

If this feature is enabled, you can use the Record on Demand (ROD) 
feature key to record your telephone conversation.

Click the ROD key to start or stop the call recording. This key is 
associated with the active user ID and is displayed only if a call is active. 
The ROD key blinks while it is connecting to the call recording application, 
and is lit when the call is recording.

The ROD key is displayed in the following scenarios:

• Normal operation - Click the ROD key during an active call to record 
the call.

• Call Recording (CR) application in ROD Mode - Click the ROD key 
during an active call to record the call

• Bulk Recording - For an active call or unregistered DN/Position ID, 
call recording is initiated even though the ROD key is not pressed..

1. Click the ROD key during an active call. 
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Using SAVE key
Use the SAVE feature key to save the recording of an active call. This key 
is associated with the active user ID and is operational only if a call is 
active.

The SAVE key is displayed in the following scenarios:

• Normal operations - If the SAVE key is clicked during an active call, 
the call is saved.

• CR application in Bulk Record + Save everything mode - Recorded 
conversation is saved at the end of the call. If the SAVE key is 
clicked, then the call is not saved.

• CR application in Bulk Record + Delete everything mode - Recorded 
conversation is deleted at the end of the call. If the SAVE key is 
clicked, then the call is saved.

The SAVE key lamp status depends on the status of the call recording. If 
the call is to be saved, then the lamp is lit..

2. To stop the call recording, click the  ROD 
key again.

1. Click the ROD key during an active call. 

2. To stop the call recording, click the ROD 
key again.

3. Click the SAVE key to save the 
conversation.
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Using NotReady

Use the NotReady feature to take your telephone out of the call queue 
while completing post-call work. The NotReady indicator remains lit as 
long as the feature is active.

Note: If you don’t activate Make Set Busy or Not Ready, the system 
will continue to direct callers to your phone.

To temporarily log out of the system, click NotReady.

To return to the queue, click NotReady or InCalls.

Answering or making non-ACD calls

Use the non-ACD calls feature to receive and place calls using your 
individual line. The indicator remains lit while the call is active.

Placing a call
1. Click your individual DN key.
2. Use the keypad to dial the telephone number.

Answering a call
When the indicator next to your individual DN key flashes, click DN. The 
indicator remains lit as long as the call remains active.

Contacting your supervisor

Use the Supervisor feature to do the following:

• Answer a call from your supervisor

• Answer a call from your supervisor when on a call

• Place a call to your supervisor

• Conference in your supervisor to a call in progress

• Transfer a call to your supervisor
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Answering a call from your supervisor
When the indicator next to the Supervisor key flashes, click Supervisor.

The indicator remains lit as long as the call remains active. 

Answering a call from your supervisor when on a 
call
Answering a call from your supervisor when on another call.  When the 
indicator next to the Supervisor key flashes, you can do any of the 
following:

• To put the current call on hold, click Hold.

• To speak to your supervisor, click Supervisor.

• To return to the active call, click InCalls. 

Placing a call to your supervisor when on a call
To place a call to your supervisor:

1. Click Supervisor. Calls are automatically put on hold when using 
Supervisor.

2. To return to the current call, click InCalls.

Conferencing your supervisor to a call in progress
You can conference in your supervisor to a call in progress:

• To talk privately with your supervisor, click Supervisor.

• Click Supervisor twice to activate a conference call that includes 
you, your supervisor, and the current caller.

Transferring a call to your supervisor 
To transfer a current call to your supervisor:

1. Click Supervisor.

2. When your supervisor answers, click Supervisor again.

3. To terminate your access to the call, click Goodbye.

Download from Www.Somanuals.com. All Manuals Search And Download.



Supervisor features

45

Supervisor features

This section describes the following features that are available to 
supervisors:

• “Using Answer Agent” on page 45

• “Using Agent key” on page 46

• “Using Answer Emergency” on page 46 

• “Using Call Agent” on page 47

• “Using Interflow” on page 47

• “Using Night Service” on page 47

• “Using Observe” on page 48

• “Using Display Agent Status” on page 49

• “Using Display Queue” on page 50

Using Answer Agent

Use Answer Agent to receive calls from agents in a non-emergency 
situation. Your status changes to NotReady and the indicator remains lit 
as long as the call is active.

To use the Answer Agent feature, do the following: 

1. When the indicator next to the Answer Agent key flashes, click 
Answer Agent.
The Agent ID of the person contacing you display on your telephone.

2. To end the call, click Goodbye.

Note: The LCD remains lit as long as you are on the call, and your 
status is displayed as NotReady. If configured, your status is 
displayed as Not Ready in Contact Center Manager Administration 
Real Time Display.
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Using Agent key

Use the Agent feature to connect, observe, or monitor the status of each 
agent position. Each Agent key links to a particular agent position when 
used with the Call Agent or Observe Agent key.

To activate the Agent feature:

1. Click Call Agent or Observe Agent.

2. Click Agent. 
Table 2 lists agent status indications.

Using Answer Emergency

Use the Answer Emergency feature to receive calls from agents in an 
emergency situation. Your status changes to NotReady and the indicator 
remains lit as long as the call is active.

To use the Answer Emergency feature, do the following:

1. When the indicator next to the Answer Emergency key flashes, click 
Answer Emergency.
Note: The Agent ID of the individual contacting you is displayed on 
your telephone.

2. To end the call, click Goodbye.

Table 2: Agent Status

Indicator Display Meaning

Off Agent is not logged in.

On Agent is logged in but is either NotReady or on 
a call.

Slow Flashing Agent is waiting for an ACD call.

Fast Flashing Agent is on a non-ACD call.
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Note: If Contact Center Manager Administration is in use, and if 
multiple Agents have pressed Emergency, the connected PC 
displays a list of Agents who have pressed Emergency.

Using Call Agent

Use the Call Agent feature to contact an agent.

To use the Call Agent feature, do the following:

1. Click Call Agent.

2. Click a selected Agent key or dial the agent’s Position ID.

3. To end the call, click Goodbye.

Using Interflow

Use the Interflow feature to redirect calls when the backlog or wait time 
exceeds a predefined threshold. The Interflow indicator flashes while the 
feature is active.

To use the Interflow feature, do the following:

1. Click Interflow.

2. Click Interflow again to deactivate the feature and resume normal 
call flow.

Using Night Service

Use the Night Service feature to define how calls are handled outside of 
business hours. When Night Service is active, the indicator lights 
continuously and all new calls and calls already in the queue receive night 
service.
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Activating Night Service
To activate Night Service, do the following:

1. Click Night.

2. Click the 6 key (N for Night) to go into Night Service.

Transitioning to Night Service
To transition into Night Service, do the following:

1. Click Night.

2. Click the 8 key (T for Transition) to activate Transition mode.

Note: The Night Service indicator flashes. All calls in the queue 
remain in the queue and new calls receive night service.

Deactivating Night Service
To deactivate Night Service, do the following:

1. Click Night.

2. Click the 3 key (D for Day) to resume Day mode.

Note: The Night Service indicator flashes, and new calls enter the 
queue. 

Using Observe

Use the Observe feature to monitor an agent in a call.

Note: This feature creates a three-party conference with the 
Supervisor, Agent and Customer.

To activate the Observe feature, do the following:

1. Click Observe.

2. Do one of the following:

— Click a selected Agent key.

— Dial the agent’s Position ID. 

— To talk to the agent you are monitoring, click Call Agent.
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3. To terminate the observation, click Observe.

Using Display Agent Status

Use the Display Agent feature to view a summary of current status for all 
agents that have an agent Position ID key assigned on the Supervisor’s 
telephone. See Figure 4 below.

Click Display Agent. The summary information appears for 12 seconds 
or until you click another feature key.

In the NotReady state, agent positions on either ACD or non-ACD calls 
count as busy. Your system administrator specifies whether calls are 
ACD or non-ACD.

Figure 4: Display Agent Status

Positions busy on
ACD calls

Positions waiting
for ACD calls

Positions busy on
non-ACD calls

Vacant agent
positions
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Using Display Queue

Use the Display Queue feature to view the status of all calls waiting in the 
queue.

To activate Display Queue, click Display Queue.

Your queue status appears in the display area of the Call Control window.  
See Figure 5 below.

Figure 5: Display Queue

To view the amount of call traffic in the ACD queue, observe the indicator 
beside the Display Queue key. Table 3 lists the four indicator states.

Table 3: Display Queue indicators

Indicator Queue Status Meaning

Off Light You have few or no calls 
waiting.

On Normal You have an acceptable 
number of calls waiting.

Calls Waiting

Number of
active positions

Calls time overflowed
into this queue

Length of time first
call has waited
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Slow Flashing Busy Calls are backing up in the 
queue. Calls overflowing 
to this queue are not being 
accepted.

Fast Flashing Overloaded You have too many calls 
in this queue. New calls 
overflow to another queue.

Table 3: Display Queue indicators

Indicator Queue Status Meaning
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No Supervisor ID, With Priority, 35
Non-ACD calls, 43
NotReady, 36, 37, 43

O
Observe Agent, 46
Observe, 48
Outbox/Shift, 25

P
Primary display, 22
Priority 36

Q
Quit, 22

R
Release, 24

S
Services, 24
Soft keys, 22
Supervisor ID 34
Supervisor ID, 34
Supervisor ID, No Priority, 35
Supervisor ID, With Priority, 36
Supervisor, 44
System tray icon, 18, 27
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Voice over IP (VoIP), 15
Volume, 23

W
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